
CBS Pro Version 20.1 - Examples page: 1

© Robobat www.robobat.com

1. EXAMPLE OF LOAD DEFINITION IN THE CBS Pro
PROGRAM

1.1. Introduction
The example below presents possibilities of load definition in the CBS Pro program. It also illustrates
new capabilities of CBS Pro version 20.1. To make definition of a geometrical model easier, the 
example is based on a simple structure of a small building with wooden rafter framing. 

The following rules apply to the example below: 

 any icon symbol means ‘press the relevant icon with the left mouse button’,

 {x,x y,y} means ‘using the mouse cursor indicate the point with the coordinates X=x,x Y=y,y’
(the value specified may be approximate if it refers to a structure snap point),

 d stands for ‘enter the ‘d’ text to the field indicated in the text’ 

 d stands for ‘enter the ‘d’ text directly from the keyboard’ (without reference to an edit field) 

 (), (), (), () stands for ‘press the relevant arrow key on the keyboard’

 ()+() stands for ‘press simultaneously two arrows on the keyboard’

 Enter, Ctrl, Delete, ESC mean ‘press the button Enter, Ctrl, Delete, ESC, respectively on the 
keyboard’; the ‘+‘ sign indicates that pressing of the above-mentioned key on the keyboard is 
linked with pressing of another key that follows after the ‘+‘ sign 

 LMC, RMC: abbreviations for the Left Mouse button Click and the Right Mouse button Click 

 the following units are applied in the example: structure dimension [m], section dimension [cm], 
angle [Deg] (default units may be changed by the user in the Preferences dialog box on the Units
tab - available in the Tools / Preferences menu). 

To start work in the CBS Pro program, the user should press the icon on the computer desktop 
or select the CBS Pro command from the START menu.  
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NOTE: The CBS Pro program version 20.1 may be run in two different configurations: with 
load module or without this module. To check the current program configuration, the 
user should select the Preferences option from the Tools menu and next, in the 
Preferences dialog box move to the Configuration tab. To perform the example 
below correctly, the option Geometrical model with loads has to be chosen. If different 
option is selected (only geometrical modeler), then the icon Geometrical model with 
loads should be pressed. To update the configuration, the program has to be closed 
and then restarted. If the Geometrical model with loads option is not active, then the 
user should run the installation program again and using the Modify mode – should 
install the load module. Detailed information concerning this can be found in the CBS 
Pro program help (Program Installation / Installation Program). 
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1.2. Definition of Sections and Materials

(Section Database – the 
Properties toolbar)

Opens the Section Database dialog box which enables 
definition of new sections. 

LMC on the Rectangular option in 
the tree in the left part of the dialog 
box 

Selects the section type – rectangular sections. The active 
section type becomes highlighted. 

(Add section) Adds a new rectangular section.

In the b field enter value 15.0 and in 
the h field 17.5

Defines section dimensions.

LMC on the option in the tree in the 
left part of the dialog box with a 
default section name

Sets the current section.

Again LMC on the same option in 
the tree 

Activates edition of the section name.

In the active field enter 
R15*17.5
Enter

Changes the section name.

(Add section) Adds a new rectangular section.

In the b field enter value 15.0, in the 
h field 15.0

Defines section dimensions.

(Add section) Adds a new rectangular section.

In the b field enter value 35.0, in the 
h field 35.0

Defines section dimensions.

LMC on the T-sections option in the 
tree in the left part of the dialog box

Selects the section type – T-sections. The active section 
type becomes highlighted.

(Add section) Adds a new T-section.

In the b field enter value 35.0, in the 
h field 75.0, in the bf field 75.0 and 
in the hf field 25.0

Defines section dimensions.

LMC on the Walls (slabs) option in 
the tree in the left part of the dialog 
box 

Selects the section type – sections for walls and slabs. The 
active section type becomes highlighted.

(Add section) Adds a new section for walls or slabs.

In the b field enter value 35.0 Defines section thickness.

LMC on the Rectangular openings 
option in the tree in the left part of 
the dialog box 

Selects the section type – rectangular openings. The active 
section type becomes highlighted. 

(Add section) Adds a new rectangular opening.
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In the l field enter the value 90.0 and 
in the h field 210.0

Defines opening dimensions.

(Add section) Adds a new rectangular opening.

In the l field enter the value 180 and 
in the h field 150

Defines opening dimensions.

LMC on the OK button Closes the dialog box and accepts the operations 
performed.

(Material Database – the 
Properties dialog box)

Opens the Material database dialog box which enables 
definition of new materials.

LMC on the Layered material option 
in the tree in the left part of the 
dialog box 

Selects the material type – layered material. The active 
material type becomes highlighted.

(Add material) Adds a new layered material.

From the list in the Material field in 
the first table row select Cement 
mortar 

Defines first material layer. Non-structural material.

To the Thickness field in the same 
row enter value 5 cm. 

Defines thickness of the first material layer.

From the list in the Material field in 
the second table row select Foamed 
polystyrene

Defines second material layer. Non-structural material.

To the Thickness field in the same 
row enter value 10 cm

Defines thickness of the second material layer.

From the list in the Material field in 
the third table row select Concrete

Defines third material layer. Structural material.

To the Thickness field in the same 
row enter the value 25 cm

Defines thickness of the third material layer.

LMC on the option in the tree in the 
left part of the dialog box with a 
default material name

Sets the current material.

Again LMC on the same option in 
the tree

Activates edition of the material name.

To the active field enter: 
SLAB_L
Enter

Changes name of the material

(Add material) Adds a new layered material.

From the list in the Material field in 
the first table row select Foamed 
polystyrene

Defines first layer of the material. Non-structural material.
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To the Thickness field in the same 
row enter value 5 cm

Defines thickness of the first material layer. 

From the list in the Material field in 
the second table row select Concrete

Defines second layer of the material. Non-structural 
material.

To the Thickness field in the same 
row enter value 25 cm

Defines thickness of the second material layer.

LMC on the option in the tree in the 
left part of the dialog box with a 
default material name

Sets the current material.

Again LMC on the same option in 
the tree

Activates edition of the material name.

To the active field enter 
WALL_L
Enter

Changes name of the material.

LMC on the OK button Closes the dialog box and accepts the operations 
performed. 

1.3. Generation of the Structure Model 

(Default Sections 
- the Properties toolbar)

Opens the Default Sections dialog box where default 
sections for newly-defined elements can be determined. 

From the Beams list select section 
R15*17.5

Sets the R15*17.5 section as a default one for newly-
defined beams. 

From the Columns list select section 
R35*35

Sets the R35*35 section as a default one for newly-defined 
columns. 

From the Continuous Footings list 
select section T75*25

Sets the T75*25 section as a default one for newly-defined 
continuous footings.

From the Windows list select section 
RH180*150

Sets the RH180*150 rectangular opening as a default one 
for newly-defined windows.

From the Doors list select section 
RH90*210

Sets the RH90*210 rectangular opening as a default one 
for newly-defined doors. 

LMC on the OK button Closes the dialog box and accepts the operations 
performed.

(Default Materials 
- the Properties toolbar)

Opens the Default Materials dialog where default 
materials for newly-defined elements can be determined. 

From the Beams list select material 
Pine

Sets the Pine material as a default one for newly-defined 
beams.

From the Columns list select
material Concrete

Sets the Concrete material as a default one for newly-
defined columns. 
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From the Walls list select material 
WALL_L

Sets the WALL_L material as a default one for newly-
defined walls.

From the Slabs list select material 
SLAB_L

Sets the SLAB_L material as a default one for newly-
defined slabs.

LMC on the OK button Closes the dialog box and accepts the operations 
performed.

(Wall – the Objects toolbar) Switches on the option of wall definition.

(Drag – the Edit - Modes toolbar) Switches on the option enabling definition of objects as 
a chain – polyline. 

-5.0
Enter  

Enters the beginning point of the wall chain.
NOTE: The option displays the dialog box into which 
relative coordinates may be entered from the keyboard. 

()
10.0

Enters the next point of the wall chain. 

()
2.5

Enters the next point of the wall chain.

()+()
1.5

Enters the next point of the wall chain. 

()
8,5

Enters the next point of the wall chain.
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()
4,0

Enters the next point of the wall chain.

(Snap Cursor to Object Ends –
the Snap toolbar)

Switches on the option which snaps the cursor to object 
ends. 

(Snap Cursor to Object Centers 
– the Snap toolbar)

Switches on the option which snaps the cursor to object 
centers.

(Door – the Objects toolbar) Starts definition of a door.

LMC on the grid node with 
coordinates: {-1.0 2.0}

Defines a door.

(Window – the Objects toolbar) Starts definition of windows.
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LMC on the grid nodes with 
coordinates: {-5.0 2.0}; {-5.0 -2.0}

Defines two windows.

LMC in the middle of the slanting 
wall 

Defines a window.

(Select - the Objects toolbar) Switches on the option allowing element selection.

LMC in the top left corner of the 
screen showing a structure view and 
next, holding the left mouse button 
pressed, move the cursor to the 
bottom right part of the screen so 
that the selection rectangle contains 
all the defined elements  

Selects objects.
NOTE: The user may use the Ctrl+A key shortcut –
selection of all elements.

(Vertical Mirror – the Edit toolbar) Switches on the option making mirror reflection with 
respect to axis.

LMC on the grid node with 
coordinates: {0.0 5.0}

Defines the symmetry axis for vertical mirror.

(Column – the Objects toolbar) Switches on the option of column definition.
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LMC on the grid nodes with the 
coordinates: {-1.0 5.0} and next, {1.0 
5.0}

Defines columns.

(Wall - the Objects toolbar) Switches on the option of wall definition.

(Drag – the Edit - Modes toolbar) Switches on the option allowing definition of objects as 
a chain – polyline. 

LMC on the grid nodes with 
coordinates {-1.0 -5.0} and next, on 
{1.0 -5.0}
Esc

Defines a wall.

LMC on the grid node with 
coordinates {-1.0 0.0} and next, on 
{1.0 0.0}
Esc

Defines the next wall.

LMC on the point of intersection 
between the left slanting wall and 
the wall parallel to Y axis {-1.0 3.5} 
and next, LMC on the point of 
intersection between the right 
slanting wall and the wall parallel to 
Y axis {1.0 3.5}

Defines the next wall.

(Door - the Objects toolbar) Starts definition of a door.

LMC in the middle of the previously 
defined wall {0.0 3.5}

Defines a door.

LMC on the grid node with 
coordinates: {0.0 0.0}

Defines a door.
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(Slab - the Objects toolbar) Switches on the mode of slab definition.

(Add Specially - the Objects 
toolbar)

Switches on the special mode of slab definition.

LMC within the large room on the 
left, e.g. on the point { -3,0 0,0}

Defines a floor slab.

LMC within the large room on the 
right, e.g. on the point { 3,0 0,0}

Defines a floor slab.

LKM within the smaller room 
positioned under X axis, e.g. on the 
point { 0,0 -2,0}

Defines a floor slab.

(Add Specially - the Objects 
toolbar)

Switches off the special mode of slab definition.
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Starting with the grid node of the 
coordinates {-1.0 0.0} LMC -
clockwise - on the points with the 
following coordinates: {-1.0 3.5} {-2.5 
5,0} {2.5 5.0} {1.0 3.5} {1.0 0.0} {-1.0 
0.0}

Defines a slab – the user creates contour of the slab 
comprising the smaller room positioned above X axis and 
the balcony. 

From the View menu select the 
Architectural View option 

Changes the mode of element presentation (the option is 
active after starting up the program).
NOTE: The option is also available through the F10 key 
shortcut. 

From the View menu select the 
Structural View option 

Changes the mode of element presentation.
NOTE: The option is also available through the F9 key 
shortcut.

From the Story menu choose the 
Copy option 

Opens the dialog box for copying stories.
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Into the to: field enter value 1 Determines the number and positions of copied stories.

LMC on the OK button Performs the copy operation. Closes the dialog box.

From the Story no. list on the Story
toolbar select the story 0

Changes the current story.

(Continuous Footing – the 
Objects toolbar)

Switches on the mode of continuous footing definition.

(Drag – the Edit – Modes toolbar) Switches on the option enabling definition of objects as 
a chain – polyline. 

LMC – four times – on the grid 
nodes with coordinates {-5.0 -5.0}, {-
5.0 5.0}, {5.0 5.0}, {5.0 -5.0}

Defines outer continuous footings.

(Drag – the Edit – Modes toolbar) Switches on the option enabling definition of objects as 
a chain – polyline.

LMC on the grid node with 
coordinates {-5.0 -5.0}

Completes definition of outer continuous footings.

LMC on the grid node with 
coordinates {-1.0 -5.0 } and next, 
LMC on the point of intersection 
between the left slanting wall and 
the wall parallel to Y axis {-1.0 3.5}

Definition of inner continuous footing.

LMC on the point of intersection 
between the left slanting wall and 
the wall parallel to Y axis {-1.0 3.5}, 
next, LMC on the point of 
intersection between the left slanting 
wall and the outer wall parallel to X 
axis 
{-2.5 5.0}  

Definition of inner continuous footing.

LMC on the grid node with 
coordinates {1.0 -5.0} and next, LMC 
on the point of intersection between 
the right slanting wall and the wall 
parallel to Y axis {1.0 3.5}

Definition of inner continuous footing.

LMC on the point of intersection 
between the right slanting wall and 
the wall parallel to Y axis {1.0 3.5}, 
next, LMC on the point of 
intersection between the right 
slanting wall and the outer wall 
parallel to X axis {2.5 5.0}

Definition of inner continuous footing.

LMC on the bottom right window of 
the program presenting 3D view of 
the structure  

Changes the active program window. 
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(3D (Whole Building)) – the 3D 
View toolbar)

Switches on 3D view of the entire structure.
Note: If an operating system other than Windows NT is 
used and DirectX v.8 or higher is installed on the computer, 
then by using (3D Model with Rendering – the 3D View 
toolbar) the user may switch on a view showing filled 
surfaces with shadows.

LMC on the left main program 
window

Changes the active program window. 

From the Story no.: list on the Story
toolbar select story 1

Changes the current story.

From the View menu choose the 
Display option 

Opens the Display dialog box.
NOTE: The Display option is also available in the context 
menu.

LMC on the None button Switches off display of all elements.

On the Objects tab LMC on the 
Beams option 

Switches on display of beams. 

LMC on the Apply button Confirms selection and closes the dialog box.

(Beam – the Objects toolbar) Switches on the option of beam definition.

LMC on the grid node with the 
coordinates {0.0 -5.0} and next, on 
{0.0 5.0}

Defines the roof ridge beam.

LMC on the grid node with the 
coordinates {0.0 -5.0} and next, on {-
5.0 –5.0}

Defines outer rafters.

LMC on the grid node with the 
coordinates {0.0 -5.0} and next, on 
{5.0 -5.0}

Defines outer rafters.

LMC on the grid node with the 
coordinates {0.0 5.0} and next, on {-
5.0 5.0}

Defines outer rafters.
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LMC on the grid node with the 
coordinates {0.0 5.0} and next, on 
{5.0 5.0}

Defines outer rafters.

LMC on the grid node with the 
coordinates {-5.0 -5.0} and next, on 
{-5.0 5.0}

Defines outer ground beams.

LMC on the grid node with the 
coordinates {5.0 -5.0} and next, on 
{5.0 5.0}

Defines outer ground beams.

LMC anywhere in the graphical 
viewer

Switches off selection of elements.

(Select – the Objects toolbar) Switches on the option enabling selection of elements.
Note: The Select option is also available in the context 
menu. 

Holding the Ctrl key pressed – LMC 
on the two earlier-defined ground 
beams

Selects objects.
Note: The user may also select these objects by making 
several successive window selections holding the Ctrl key 
pressed. 

(Properties - the Objects 
toolbar)

Opens the dialog box with object properties.

From the Section list select P15*15 Changes beam section from 15x17.5 to 15x15 [cm].

Enter Confirms changes and closes the dialog box. 
Note: If the option on the bar in the properties dialog 
box is not switched on, then the dialog box does not close 
automatically after pressing Enter.

(Select – the Objects toolbar) Switches on the option enabling element selection.
Note: The Select option is also available in the context 
menu.

LMC on the roof ridge beam Selects objects.

(Translate – the Edit toolbar) Opens the Translation dialog box.

Into the z= field enter value 3.0 Defines translation vector.

LMC on the Fit adjoining elements
option

Switches on the option which ensures that neighboring 
elements are fitted to each other.

LMC on the Apply button Performs the operation of translation.

LMC on the Close button Closes the dialog box for definition of grids and axes.

(Beam - the Objects toolbar) Switches on the option of beam definition.

From the list on the Properties
toolbar choose the section P15*17.5 

Changes section for newly-defined beams.
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LMC on the grid node with the 
coordinates {2.0 4.0} and next, on
{2.0 -4.0}

Defines purlins.

LMC on the grid node with the 
coordinates {-2.0 4.0} and next, on {-
2.0 -4.0}

Defines purlins.

(Select – the Objects toolbar) Switches on the option enabling selection of elements.
Note: The Select option is also available in the context 
menu. 

Holding the Ctrl key pressed – LMC 
on four outer rafters one by one 

Selects objects.
Note: The user may also select these objects by making 
several successive window selections holding the Ctrl key 
pressed.

(Extend – the Edit modes) Switches on the option enabling elongation of elements. 

LMC on two purlins one by one Elongates purlins so that they reach rafters with automatic 
fitting of elements in 3D space. 

(Beam – the Objects toolbar) Switches on the option of beam definition.

LMC on the grid node with the 
coordinates {-3.0 3.0} and next, on 
{3.0 3.0}

Defines a collar beam.

(Select – the Objects toolbar) Switches on the option of element selection.
Note: The Select option is also available in the context 
menu.

Holding the Ctrl key pressed – LMC 
on both purlins one by one 

Selects objects.
Note: The user may also select these objects by making 
several successive window selections holding the Ctrl key 
pressed.

(Cut Off - the Edit toolbars) Switches on the option enabling trimming elements.

LMC one by one on points near both 
ends of the collar beam

Trims both ends of the collar beam so that they fit purlins 
with automatic fitting of elements in 3D space. 

(Select – the Objects toolbar) Switches on the option enabling selection of elements.
Note: The Select option is also available in the context 
menu.

LMC on the collar beam Selects objects.

(Translate – the Edit toolbar) Opens the Translation dialog box.

LMC on the grid node with the
coordinates {0.0 3,0} and next, on 
{0.0 1.0}

Defines the translation vector graphically.

LMC on the Copy option Switches on the copying option.
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Into the Number of repetitions field 
enter 3

Determines the number of repetitions for the copy 
operation.

LMC on the Apply button Performs the copy operation.

LMC on the Close button Closes the dialog box for definition of grids and axes.

(Select – the Objects toolbar) Switches on the option enabling selection of elements.
Note: The Select option is also available in the context 
menu. 

Holding the Ctrl key pressed – LMC 
one by one on two outer rafters 
positioned in the top part of the 
screen 

Selects objects.
Note: The user may also select these objects by making 
several successive window selections holding the Ctrl key 
pressed.

(Translate – the Edit toolbar) Opens the Translation dialog box.

LMC on the grid node with the 
coordinates {0.0 3.0} and next, on 
{0.0 1.0}

Defines the translation vector graphically. 

LMC on the Copy option Switches on the copying option.

Into the Number of repetitions field 
enter 4

Determines the number of repetitions for the copy 
operation.

LMC on the Apply button Performs the copy operation.

LMC on the Close button Closes the dialog box for definition of grids and axes.

From the View menu select the 
Synchronize Views option 

Switches on the work mode (structural / architectural) 
synchronization and display in all the layouts.
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(Wall – the Objects toolbar) Switches on the option of wall definition.

LMC on the grid node with the 
coordinates {-5.0 4.0} and next, LMC 
on the grid node with the coordinates  
{5.0 4.0}

Defines a gable wall.
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Answer ’yes’ to the question that 
appears on the screen asking 
whether wall display should be 
restored 

Restores display of walls.
Note: The Display option is available in the context menu 
and in the main program menu: View / Display. 

(Select – the Objects toolbar) Switches on the option enabling selection of elements.
Note: The Select option is also available in the context 
menu.

LMC on the newly-defined gable wall Selects objects.

(Translate – the Edit toolbar) Opens the Translation dialog box. 

Into the z= field enter value 3.0 Defines translation vector.

LMC on the Apply button Performs the operation of translation.

LMC on the Close button Closes the dialog box for definition of grids and axes.

(Properties – the Objects 
toolbar)

Opens the dialog box with object properties.

LMC on the Position tab Changes the tab in the Object Properties dialog box.

(Detailed Wall Presentation - the 
Object Properties dialog box)

Changes wall presentation from the simplified description 
to the detailed one 

LMC on the third row of the table 
with wall coordinates 

Activates the row describing third characteristic point of the 
wall. 

(Delete Row – the Object 
Properties dialog box)

Deletes the third characteristic point of the wall.

LMC on the table field in the x[m]
column in the third row

Activates the edit field. Its color changes to green, the 
value may be modified. 

Into the active field enter 0.0 Changes position of the third characteristic point of the 
gable wall. 

Enter Accepts changes and closes the dialog box. 
Note: If the option on the bar in the properties dialog 
box is not switched on, then the dialog box does not close 
automatically after pressing Enter.

(Translate – the Edit toolbar) Opens the Translation dialog box.

(on the bar in the Object 
Properties dialog box)

Switches off the option that closes the dialog box 
automatically once the operation is performed. 

LMC on the grid node with the 
coordinates {0.0 4.0} and next, on 
{0.0 -5.0}

Defines translation vector graphically.

LMC on the Copy field Switches on the copying option.
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LMC on the Apply button Performs the operation of translation.

LMC on the Copy field Switches off the copying option.

Into the y= field enter the value 1.0 Defines translation vector.

LMC on the Apply button Performs the operation of translation.

LMC on the Close button Closes the Translation dialog box.

From the View menu choose the 
Display option 

Opens the Display dialog box.
NOTE: The Display option is also available in the context 
menu.

LMC on the All button Switches on display of all objects.

LMC on the Apply button Accepts selection and closes the dialog box. 

1.4. Definition of Loads
From the Edit menu select the 
Default Values / Loads option 

Displays dialog box with default loads.

LMC on the LIVE option in the tree 
in the left part of the dialog box  

Selects nature of a new load group - live. The active load 
type becomes highlighted. 

(Add) Adds a new group of live loads.

LMC on the new highlighted option 
in the tree in the left part of the 
dialog box  

Activates edition of the group’s name.

Into the active field enter 
Live_building,
Enter

Changes name of the load group.
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Into the Planar field in the right part 
of the dialog box enter 5.0

Assigns the default value of planar loads 5.0 [kN/m2] to the 
group. 

Into the Load factor field in the right
part of the dialog box enter 1.3

Assigns load factor 1.3 to the group. 

LMC on the OK button Confirms changes and closes the dialog box.

From the Story no.: list on the Story
toolbar select story 0

Changes the current story.

(Planar Load – the Loads 
toolbar)

Chooses load type.

From the list on the Loads toolbar 
select group Live_building 

Changes the current load group.

LMC - four times - within successive 
floor slabs beginning with the large 
floor on the left and next, clockwise 
on the points, e.g.: {-3.0 0.0} {0.0 
1.0} {3.0 0.0} {0.0 -1.0}

Applies live loads to floor slabs.

(Generate – the Loads toolbar) Generates load patterns for the defined live loads. 

(Display - the Loads toolbar) Displays dialog box with the list of current load patterns. 

LMC on the first item on the list in 
the left part of the dialog box 

Indicates the current load pattern.
NOTE: Load patterns are presented in 3D view.

() Views successive load patterns.
NOTE: Load patterns are presented in 3D view.

LMC on the first 3-element load 
pattern 

Indicates the current load pattern.
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LMC on the Delete pattern button in 
the top part of the dialog box 

Deletes the current load pattern.

Repeat the operation of deleting 
three times for all the 3-element load 
patterns one by one

Deletes the remaining 3-element load patterns.

LMC on the Close button Closes the dialog box.

From the Story no.: list on the Story
toolbar select story 1

Changes the current story.

From the View menu choose the 
Display option 

Opens the Display dialog box. 
NOTE: The Display option is also available in the context 
menu. 

LMC on the None button Switches off display of all the objects.

On the Objects tab - LMC on the 
Beams option 

Switches on display of beams.

LMC on the Apply button Confirms selection and closes the dialog box. 

(Linear Load – the Objects 
toolbar)

Selects load type.

From the list on the Loads toolbar 
choose the Wind group 

Changes the current load group.

Into the edit field on the Loads
toolbar enter –0.75

Changes the load value.

LMC - twice - on the outer rafters on 
the left side of the building, e.g. on 
points {-1.0 -5.0 } {-1.0 5.0 }

Applies wind loads to outer rafters on the left side of the 
building.

Into the edit field on the Loads
toolbar enter -0.5

Changes the load value.

LMC - twice - on the outer rafters on 
the right side of the building, e.g. on 
points {1.0 -5.0 } {1.0 5.0 }

Applies wind loads to outer rafters on the right side of the 
building.

Into the edit field on the Loads
toolbar enter -1.5

Changes the load value.

LMC – four times – on inner rafters 
on the left side of the building, e.g. 
on points {-4.0 -3.0 } {-4.0 -1.0} {-4.0 
1,0 } {-4.0 3.0 } 

Applies wind loads to inner rafters on the left side of the 
building.

Into the edit field on the Loads
toolbar enter -1.0

Changes the load value.
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LMC – four times – on inner rafters 
on the right side of the building, e.g. 
on points {4.0 -3.0} {4.0 -1.0} {4.0 
1.0} {4.0 3.0}

Applies wind loads to inner rafters on the right side of the 
building.

From the View menu choose the 
Display option 

Opens the Display dialog box.  
NOTE: The Display option is also available in the context 
menu. 

On the Objects tab - LMC on the 
Walls option 

Switches on display of walls.

On the Objects tab - LMC on the 
Beams option 

Switches off display of beams.

LMC on the Apply button Confirms selection and closes the dialog box.

(Planar Load – the Loads 
toolbar)

Selects the load type.

From the list on the Loads toolbar 
choose the Wind group 

Changes the current load group.

Into the edit field on the Loads
toolbar enter 0.25

Changes the load value.

LMC on the outer wall on the left 
side of the building 

Applies the load to the wall on the left.

Into the edit field on the Loads
toolbar enter 0.1

Changes the load value.
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LMC on the outer wall on the right 
side of the building  

Applies the load to the wall on the right.

From the Story no.: list on the Story
toolbar select story 0

Changes the current story.

Into the edit field on the Loads
toolbar enter 0.25

Changes the load value.

LMC on the outer wall on the left 
side of the building 

Applies the load to the wall on the left. 

Into the edit field on the Loads
toolbar enter 0.1

Changes the load value.

LMC on the outer wall on the right
side of the building 

Applies the load to the wall on the right. 

From the View menu choose the 
Display option 

Opens the Display dialog box.
NOTE: The Display option is also available in the context 
menu. 

LMC on the All button Switches on display of all the objects. 

LMC on the Apply button Confirms selection and closes the dialog box.
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(Export to the ‘Robot’ Program –
the Standard toolbar)

Runs generation of the calculation model in the Robot 
Millennium program.
Note: It is required that Robot Millennium program v. 15.0
or higher be installed on the computer. If several program 
versions are installed on the computer, the generation is 
performed in the recently-run version.
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